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1. BENEFITS AND FEATURES 
1.1 GENERAL DESCRIPTION: 

The Myron L Company U2CI application allows you to transfer data via Bluetooth®1 wireless 
technology to the following Myron L Company Instruments: 

• Ultrameter II™.  
• Ultrameter III™.  
• POOLPRO™.  
• DIGITAL DIALYSATE METER™. 

1.2 BLUDOCK ACCESSORY PACKAGE CONTENTS 
• Quick Start Installation Guide.  
• Dongle for downloading data to Mac or PC platforms that do not have built-in Bluetooth® capabilities.  

1.3 U2CI APPLICATION PRODUCT HIGHLIGHTS 
U2CI™ 3.X.X for MAC will run on MAC® OS 10.6 and 10.72 and allows you to: 

• Transfer data wirelessly with accuracy, reliability and simplicity. 
• Save data files in a secure, encrypted format (.mlc). 
• Export data files in the following open formats: .csv, .xls, .xlsx and .pdf (without Optical Character 

Recognition). 
• Associate all data from a particular instrument by assigning each instrument a unique name. 
• Sort data by up to three, nested sort keys. 
• Append new measurements to saved, .mlc-formatted files. 
• Create Simple line graphs and histograms. 
• Set the instrument time and date from your computer. 
• Clear measurements stored in the instruments' memory. 
• Produce simple histograms and line graphs for each measurement type. 
• Includes a Demo data file to allow the user to experiment with the software without a connected and 

active instrument. 

NOTE: For further information, please contact the Myron L Company. 

2. GENERAL INFORMATION 
2.1 LIMITED WARRANTY 

All Myron L Company bluDock accessories have a Two Year Limited Warranty. Warranty is 
limited to the repair or replacement of the bluDock only, at our discretion. The Myron L Company 
assumes no other responsibility or liability.  

2.2 SYSTEM REQUIREMENTS 
Operating Systems: MAC OS 10.6 and 10.7.  
Disk Space: 40MB of free disk space. 

2.3 U2CI OPERATION MANUAL 
Click U2CI HELP under the HELP menu to open a .pdf file of the U2CI Operation Manual for your 
software revision. 

• NOTE:  This manual may have been updated since the release of this version of the U2CI  Software.  
The most up to date version of this manual can always be found on the Myron L Company website at; 
http://www.myronl.com/main/Operation_Manuals_DL.htm 

                                            
1 Bluetooth is a registered trademark of Bluetooth SIG 
2 MAC OS is a registered trademark of Apple, inc. 
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3. START UP 
3.1 LAUNCHING THE U2CI APPLICATION  

The U2CI application can be started several ways. 
• By double clicking the Application Icon in the U2CI application folder.  
• By clicking on the U2CI icon  in the MAC OS Dock. 
• By clicking on a U2CI alias (if you created one) on your Mac OS desktop. 
• By double-clicking on any .mlc formatted file located on your computer. 

The U2CI Welcome Screen 
Once the U2CI application has launched, the following screen will appear (Figure 1) 

 
Figure 1 

This screen includes the following: 
• Window Control Buttons for closing (Red) and minimizing (Yellow).  The maximize (Green) 

button has no effect. 
• Download data from Instrument:  

• Initiates transferring data from a Myron L Company instrument using the currently selected COM Port. 
• Open existing Document:  

• Opens a Browser window that will allow you to find and open a previously saved .mlc file. 
• Show Help:  

• Opens an electronic copy of the U2CI Operation Manual.  This is a .pdf file that is viewable and 
searchable using either Adobe Reader or MAC Preview. 

• Show this window when U2CI launches Check Box:  
• Un-check this box if you wish to skip this window on future launches of the U2CI application. 

• Recent Cases Menu: This menu lists recently opened .mlc files by file name and path. 
• The most recently saved file is at the top. 
• Double click on a file to open it. 
• The footer of this window shows the last time the .mlc File was opened. 

• Cancel: This button closes the Start Up Window without performing any actions. 
NOTE The window can be opened or reopened at any time by selecting the "Welcome to U2CI" 
command under the WINDOW menu. 

3.2 QUITTING THE U2CI APPLICATION  
To quit the U2CI Application: 
• Type ⌘+Q 
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• Choose QUIT U2CI from the U2CI drop down menu. 

4. U2CI MENUS AND COMMANDS 
4.1 SUMMARY AND WORK AREA LAYOUT 

The U2CI application work area includes (Figure 2): 
• The main U2CI Application menu bar It includes the following submenus: 

• U2CI Menu. 
• File Menu. 
• Edit Menu. 
• Instrument Menu. 
• Graph Menu. 
• Window Menu. 
• Help Menu. 
• Tool Panel (see Figure 3). 

• The Data Window:  A separate window will open for each saved file.  Each Window will 
include: 
• A Command Ribbon. 
• A Data Display Tab. 
• Graph Tabs (once you have created graphs). 
• A Reference Info Field. 
• A Footer. 

 
Figure 2 
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4.2  TOOL PANEL 
The U2CI Tool Panel contains dedicated buttons for activating functions that directly affect the 
instrument currently paired and connected to the U2CI application, The Panel may be displayed 
Vertically (Default) (Figure 3) or Horizontally (Figure 4).  
The following descriptions give a general sense of each button's function.  For more detailed 
information see U2CI Tool Panel Section 7. 
 

 
 

 
Title Bar:  Red Button closes the tool Panel.  Type Shift+Commsnd+1 to reopen it. 

Current COM Port Setting: This field shows which COM Port (and therefore which 
instrument) is currently connected to the U2CI application. 

Rotate Tool Panel Button: Click on this button to toggle the Tool Panel between 
vertical and horizontal orientation. 

Download Data from Instrument:  This button starts the transfer of data from a 
connected Instrument to the U2CI application. 

Assign Name: This button allows you to assign or change the name of a connected 
instrument.   The instrument name is always associated with data downloaded from 
that instrument. 

Set Date Time: This button allows you to set the internal date and time of a 
connected instrument. 

Erase Memory: This button allows you to erase the measurement data stored in 
the memory of a connected and instrument. 

Disconnect: This button allows you to close the connection between the U2CI and 
the instrument.  It does not un-pair the instrument from the host computer.  
 
 

 
 

 
 Figure 3 
 

 
Figure 4 
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4.3 APPLICATION MENU BAR AND COMMANDS 
Whenever the U2CI application is active, the U2CI Application Menu Bar will appear at the top of 
the MAC OS desktop.  It will include the following menus (Figure 5 through Figure 11).  

U2CI Menu 
• See Table 1 on page 8 for a short description of each command. 

 
Figure 5 

FILE Menu 
• See Table 1 on page 8 for a short description of each command. 

 
Figure 6 

EDIT Menu 
• See Table 1 on page 8 for a short description of each command. 

 
Figure 7 
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INSTRUMENT Command Menu 
• See Table 1 on page 8 for a short description of each command. 

 
Figure 8 

GRAPH Menu 
• See Table 1 on page 8 for a short description of each command. 

 
Figure 9 

WINDOW control Menu 
• See Table 1 on page 8 for a short description of each command. 

 
Figure 10 

HELP menu 
• See Table 1 on page 8 for a short description of each command. 

 
Figure 11 
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Table 1: MAC OS Menus and Commands 

MENU COMMAND 
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 NOTES: 

 STANDARD MAC OS COMMANDS 

U2CI 

ABOUT U2CI   Brief description of the U2CI and revision number. 

PREFERENCES z,  Select COM ports and set display Formats. 

HIDE U2CI  zH  Deactivates U2CI and hides its windows. 

HIDE OTHERS UzH  Deactivates all other applications and hides their windows . 

SHOW ALL
   Reactivates all applications and returns all windows to the desktop. 

QUIT zQ  Quits U2CI. Asks if altered files should be saved. 

FILE 

DOWNLOAD FROM 
INSTRUMENT ñzN  Initiates transfer of data from an instrument. Also in the INSTRUMENT Menu. 

LOAD ... ñzO  Opens and displays data from a saved .mlc file. 

OPEN RECENT
   Displays a list of the most recently opened .mlc files 

CLOSE zW  Closes the active data window. 

SAVE zS  Saves the active data window in encrypted .mlc file format. 

SAVE AS ñzS  Saves the active window as a .mlc, .xls, .xlsx, .csv or .pdf  formatted file. 

PAGE SETUP
 ñzP  Allows simple choices for printing the contents of the active data window. 

PRINT zP  Prints the contents the active data window. 

EDIT 

REFERENCE INFO zR  Toggle to Show and Hide the REFERENCE INFO field at the bottom of the Data 
Window. 

SORT
 zT  Allows user to sort the data by up to 3 sort keys. 

Reference Info Field Editing Commands – Only functional when the REFERENCE INFO field is activated. 

CUT zX  Cuts selected text from the REFERENCE INFO field.  

COPY zC  Copy's text from the REFERENCE INFO field.  

PASTE zV  Pastes text into the REFERENCE INFO field. 

DELETE   Deletes text from the REFERENCE INFO field. 

SELECT ALL zA  Selects all text in the REFERENCE INFO field. 

SPECIAL CHARACTERS UzT  Allows special characters and symbols to be input into the Reference Info window. 

INSTRUMENT 

DOWNLOAD FROM 
INSTRUMENT ñzN YES Initiates transfer of data from an Instrument. Also in the FILE menu. 

ASSIGN NAME ñzA YES Changes the name stored in the connected Instrument's memory. 

SET DATE / TIME ñzT YES Edits the connected instrument's Time and Date settings. 

ERASE MEMORY ñzE YES Erases all measurement data stored in the connected Instrument. 

DISCONNECT ñzD YES Disconnect the currently connected instrument from U2CI. 

GRAPH 
NEW LINE GRAPH   Creates a simple line graph from one data type as a new tab in the active window. 

NEW HISTOGRAM   Creates a simple histogram from one data type as a new tab in the active window. 

EDIT GRAPH
   Allows the user to edit an already existing Graph Tab. 

WINDOW 

MINIMIZE zM  Minimizes the active U2CI data window. 

ZOOM   Maximizes the active U2CI data window. 

WELCOME TO U2CI ñz1  Opens the "Welcome to U2CI" startup window if it has been closed. 

INSTRUMENT PANEL ñz2  Opens the "Tool Panel" startup window if it has been closed. 

BRING ALL TO FRONT
   Brings all U2CI windows to the font of the desktop. 

HELP 
U2CI HELP   Displays a .pdf version of the U2CI operating manual. 

MYRON L COMPANY    Opens a browser window and takes the user to the Myron L Company website. 

KEY: 
⌘ This symbol indicates the Apple Keyboard COMMAND (or "flower)" key. 
ñ This symbol indicates the SHIFT key. 
⌥ This symbol indicates the OPTION (or Alt) key. 
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4.4 DATA WINDOW COMMAND RIBBON 
Each open Data window has it's own COMMAND RIBBON (Figure 12) which includes quick 
action buttons See Table :  

 
Figure 12 

Click the PRINT button  to open the PRINT dialogue box. 

Click the SAVE button  to save the data, graphs and reference information contained 
    in this window in .mlc format. 

Toggle the REFERENCE INFO button  to Show / Hide the Reference Info field. 

Click the SORT button  to open the Multi-Key Sort dialogue box. 

Click CREATE GRAPH button  to create a new Graph Tab. 

Select an existing Graph Tab, then click the EDIT GRAPH button  to edit that graph. 
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5. U2CI DATA WINDOWS  

 
Figure 13 

 

5.1 DATA WINDOW LAYOUT 
Data that is downloaded from an instrument or loaded from a .mlc formatted data file is displayed 
in a Data Window.  This window includes:   
HEADER:  The header of each Data window contains: 
• The Title of the Window (Default title is "Untitled" until the data is saved). 
• Close, Minimize and Maximize buttons. 
• COMMAND RIBBON:   This area at the top of the window includes a variety of icons that are 

shortcuts to launch various data window functions.  See Section 4.4. 
THE DATA TAB: This tab displays the data in a tabular format with individual record organized in 
rows and the individual data fields of each record organized in column. 
• The information displayed in these columns and rows is secure and cannot be edited or 

changed. 
GRAPH TABS:  Each time a graph is created from the data in the Data Tab (see Section 9). 
• A separate tab is created that displays that graph. 

REFERENCE INFORMATION FIELD:  This is an editable field which allows the user to add 
general notes or supplementary information about the data  (see Section 8.5). 
FOOTER: The following information will appear at the bottom of the Data Window: 
• The COM port from which the data downloaded or appended to this Window most recently. 
• The current setting for the multiple key SORT feature: 

• This will list the current sort keys and whether they are set for ascending vs descending order. 
• This section will be blank until the first time the Multiple Sort function is used. 
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5.2 DATA TAB – COLUMN DEFINITIONS 
COLUMN FORMATTING: 

• The width of the various columns of the Data Tab maybe resized by: 
– Placing the cursor over the dividing line between column headings then clicking and grabbing the line, 

then slide it left or right. 
• The horizontal order of columns can be changed by: 
– Placing the cursor anywhere inside the column heading, then grabbing and sliding the column left or right 

until it is in the desired position. 

COLUMN DEFINITIONS  
List #: This is the number for the row in the data display window. It is not part of the data that is 
downloaded from the instrument.  It will not change or move when the data is sorted.  
Record #: This is the memory location where the data for this measurement was stored in the 
source instrument's memory. It will move with the data row when the data is sorted.  

• Since the data in each of the instruments memory locations can be over-written the record number is 
not always in chronological order. 

• If the data in a specific instrument memory location has been cleared, it is not included in the 
downloaded data and therefore will not appear in the U2CI window. 

Measurement: This filed shows the type of measurement that was made, such as conductivity 
(COND), resistivity (RES), Total Dissolved Solids  or MIN/SALT (TDS), pH, ORP, FCE (Fr. Chl) or 
LSI.  

• Temperature is recorded in a separate column. 
• When downloading data from ad D6 or some older 6P instruments FCE is reported as, "ORP-PPM"  in 

the measurement column.  
Value:  This field contains measured value of the reading. 
Units:  This field displays the units of measure for that measurement. 
Solution:  This field shows the Temperature Compensation Model setting of the Instrument when 
the measurement was taken.  

• Some Myron L Company Instruments can make certain measurements using more than one type of 
temperature compensation models, each of which corresponds to particular solution type (e.g. NaCl; 
KCl, 442, etc.),. 

• For LSI measurements this field will display the word "USER".  
• Except for LSI measurements, measurement types where there is only one or no temperature 

compensation curve, such as FCE, ORP, pH, etc., this field displays "NONE". 
Temp: This field displays the temperature of the solution being measured at the time of the 
measurement. 
Date: This field displays the date of the measurement. 
Time: This field displays the time of the measurement. 
FCe-Columns: Myron L Company FCE (free chlorine equivalent) ppm measurements are 
calculated based on the ORP Value and pH value of the solution. 

• FCE-ORP:  This field displays the solution's ORP mV value when the FCE measurement was made. 
• FCE-pH:  This field displays the solution's pH value when the FCE measurement was made. 

LSI-Columns: These Columns display the base values that were used to calculate the ppm value 
that is displayed in the Measurement column for LSI readings. 

• LSI-ALK:  This field displays the Alkalinity value used to calculate the LSI value. 
• LSI-HARD: This field displays the Hardness value used to calculate the LSI value. 
• LSI-pH: This field displays the pH value used to calculate the LSI value. 

Instrument : This field contains the name given to the instrument with which the measurement 
was made (see ASSIGN NAME). 

• If the instrument has not been assigned a name, this field will be blank. 
Location : Not applicable to the current desktop version of the U2CI application.  
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6. PAIRING TO AND UNPAIRING FROM AN INSTRUMENT 
6.1 GENERAL INFORMATION 

If your computer does not have a built in Bluetooth transceiver,  
• Plug the Bluetooth dongle that was included with the U2CI software into a USB port on your 

computer. 
• If you don’t have the dongle that came with the bluDock enabled instrument, one can be ordered from 

the Myron L Company. Order Part Number # BDDO.  

NOTES:  
• The passkey for ALL Myron L Company bluDock enabled devices is "1234". 
• ALWAYS write down the port designation assigned to each instrument. It should look 

something like this example:  "MyronL-03F5". 

6.2 TURNING ON THE MYRON L COMPANY INSTRUMENT'S PC MODE  
1) Turn on the PC mode for you Myron L Company instrument. 

a. Press any measurement function key on the instrument (e.g. COND, pH, ORP, etc.). 

b. Press and hold the down arrow key  until the "PC OFF" appears on the instrument's 
display.  

   
Figure 14 

c. Press the CAL button.  
– The display will briefly change to read "PC InI". 

d. Wait until the LCD changes to read PC ON 

.  
Figure 15 

 
2) IMMEDIATELY proceed to Pairing to a Myron L Company Instrument (see Section 6.3). 
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6.3 PAIRING TO A MYRON L COMPANY INSTRUMENT 
NOTE: 

If the Myron L Company Instrument times out at any time during this process, restart it and turn on the PC 
Mode (see Section 6.2). 

Generally, you may return to the paring process where you left off without restarting. 
 

To pair to a Myron L Company instrument using MAC OS 6 /7: 

1) Click on the Bluetooth icon  on the right side of the MAC OS Finder menu bar. 
• If the following menu appears (Figure 16), select "Turn Bluetooth On". 

 
Figure 16 

 
Figure 17 

2) Reopen the Bluetooth menu and select "Open Bluetooth Preferences" (Figure 17). 

      
Figure 18 

• Make sure "Discoverable" is set to ON. 
• If there are no Bluetooth devices paired to your computer you will see a window similar to that shown 

on the left in Figure 18.  Click the "Set Up New Device ..." button. 
• If there are already devices paired to your computer but the Instrument you wish to interact with is not 

on the list at the right of the window, click on the "+" button to add the instrument as a Bluetooth 
device. 

• If your instrument DOES appear on the Bluetooth preference window list, but it's Connection Status is 
shown as "NO", Skip to Section 6.4 to activate the connection. 
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3) Wait for the Myron L Company instrument to appear in the device list of the MAC OS Bluetooth 
Setup Assistant window, select it.  It should look something like "MyronL-03F5". 
• Click "CONTINUE". 

 
Figure 19 

4) When the "Attempting to pair with ..." window appears, click the "Passcode Options" 

 
Figure 20 

5) Select the "Use A Specific Passkey" option. 
6) Type the default passkey "1234" into the dialogue when it is available (this is the default 

passkey for all Myron L Company Bluetooth equipped instruments).. 
• Click "OK" to return to the previous screen. 

 
Figure 21 
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7) When the pairing is successful, the following message will appear.   
8) Click "Quit". 

 
Figure 22 

9) Now that the instrument is paired to your computer, Proceed to Section 6.4 to activate the 
connection.  
• Unless you unpair the instrument from the computer you will not need to repeat the pairing process 

again. 

 

 

6.4 ACTIVATING THE CONNECTION TO A PAIRED INSTRUMENT 
1) Return to the MAC OS Bluetooth preference window (It should still be open). 
2) Select the instrument whose connection you wish to activate. 
3) Click on the sprocket button at the bottom of the Bluetooth Setup Assistant window. 
4) Select "Edit Serial Ports" from the drop down menu. 

.  
Figure 23 



U2CI Software Application – Operation Manual for MAC OS 

U2CIV3OM-MAC 23JL14 Page 16 of 43 

5) When the Myron L Company instrument appears in the device list, select it. 
6) Click "Apply" 

 
Figure 24 

7) Once the Connection is active the Mac OS Bluetooth preference dialogue box will indicate that 
the connection is active by: 
• Turning the telltale lights for this device GREEN. 
• Showing the connection status of the device in the device list as "YES". 

 
Figure 25:  

• NOTE: Once your Myron L Company instrument times out or if the PC Mode is turned off, you may 
have to repeat the activation process described in this section when you wake up the Instrument and 
turn its PC Mode back "ON". 
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6.5 DISCONNECTING AN INSTRUMENT 
This process closes the communication port between the U2CI and the instrument without 
unpairing the instrument to the computer.   
Once an instrument is paired with a specific computer it should be disconnected before pairing 
with another computer in order to avoid the possibility of Bluetooth related communication errors. 
To Disconnect an instrument. 
1) Launch the Disconnect process by: 

• Clicking on the "DISCONNECT" button on the Instrument Panel(Figure 26). 

• Selecting the "DISCONNECT" command from the INSTRUMENT menu 
(Figure 8). 

Figure 26 
NOTES:  

• If the Disconnect button/command is grayed out, it is not necessary to perform this action. 
• Since this does not unpair the instrument from the computer, the COM port for this device will still 

appear in the Preferences/Port drop down menu. 

6.6 UN-PAIRING AN INSTRUMENT 
To completely clear the COM port so that it does not appear in the Preferences/Port drop down 
menu: 
1) Open the MAC OS Bluetooth Preference Window. 
2) Select the port for the instrument you wish to unpair. 
3) Click on the " – " button (Figure 27). 

 
Figure 27 

4) The MAC OS will ask you if you are sure, Click "Remove". 

 
Figure 28  

The next time the U2CI Preferences/Port drop down men is opened the COM port will be gone  
from the list. 
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7. U2CI INSTRUMENT FUNCTIONS 
7.1 GENERAL NOTES ON INSTRUMENT FUNCTIONS    

WARNING! 
Do Not Press any of the buttons on the keypad of the Instrument once the instrument 

related function has started.  This will cause the PC mode to turn OFF. 
 

It the PC mode is turned OFF or the Instrument times out while the U2CI function is in 
process THE U2CI APPLICATION will CRASH (see Section 10, Troubleshooting). 

 

Before launching any of the Functions described in this section make sure that : 
• The Instrument's Auto Off feature is set to "75" seconds. 
• The instrument is awake and that the PC mode is set to "ON" (see Section 6.2). 
• The instrument is paired to your computer and the connection is active (see Sections 6.3 and 6.4). 
• The correct COM port is selected in the U2CI Preference/Port drop down menu 

(see Section 7.2). 

An error message, similar to the one shown in (Figure 29), will appear if: 
• The instrument is asleep or if its PC Mode is "OFF" (see Section 6.2), or; 
• The COM port connection is inactive (see Section 6.4); 
• The wrong COM port is selected in the Preference/Port drop down menu  

(see Section 7.2). 
• EXCEPTION, If the Demo port is selected the process will proceed using the demo port simulated data.   

• The Instrument's Bluetooth signal is too weak. 
• Try moving the Instrument closer to the host computer. 
• Replace the battery (Even if the Lo Batt indicator is not lit on the Instrument display, the battery may 

be too weak to broadcast a strong signal). 

 
Figure 29  

Once the issue is corrected:  
• Click the "OK" button to proceed, or; 
• Click the "Cancel" button to abort the process. 

NOTE 
To prolong the battery life of your Myron L Company instrument, turn OFF the instruments PC mode as 

soon as you have finished interacting with the U2CI Application. 
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7.2 SELECTING A COM PORT 
1) Open the Preferences dialogue box by: 

• Selecting the "PREFERENCES" command from the "U2CI" menu  (Figure 30), or: 

  
Figure 30 

2) From Preferences/Port drop down menu, select the appropriate port / instrument ID  Figure 31). 

      
 Figure 31 

3) Click the "OK" button. 
• The new COM port will be displayed on the Tool Panel, just below the Title Bar. 

4) Click the "Cancel" button to abort the process. 
 
NOTES: 

• The COM port default setting is "DEMO".  When "DEMO" is selected, the U2CI application will 
download a set of demonstration data and allows you to explore the functionality of the U2CI 
application without being connected to an instrument. 

• Once selected the port will stay selected until you either: 
– Select another port. 
– Restore the preferences settings to their defaults. 

• If you accidentally add demo data to your data file, close the window without saving it and start over. 
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7.3 DOWNLOADING DATA 
WARNING! 

Do Not Press any of the buttons on the Keypad of the Instrument once the DOWNLOAD 
process has started. 

This will cause the PC mode to turn OFF. 
 

It the PC mode is turned OFF or the Instrument Times out while the Download is in process 
THE U2CI APPLICATION will CRASH. 

Before launching the Download process make sure that: 
• The instrument's is awake and that the PC mode is set to "ON" (see Section 6.2). 
• The instrument is paired to your computer and the connection is active (see Sections 6.3 and 6.4). 
• The correct COM port is selected in the U2CI Preference/Port drop down menu 

(see Section 7.2). 

An error message will appear, similar to the example shown in Figure 32, if: 
• The instrument is asleep or if its PC Mode is "OFF"; 
• The COM port connection is inactive, or; 
• The wrong COM port is selected in the Preference/Port drop down menu. 
• The Instrument's Bluetooth signal is too weak. 

• Try moving the Instrument closer to the host computer. 
• Replace the battery (Even if the Lo Batt indicator is not lit on the Instrument display, the battery may 

be too weak to broadcast a strong signal). 

 
Figure 32 

• Once the issue is corrected:  
• Click the "OK" button to proceed, or; 
• Click the "Cancel" button to halt the download process. 

Start the download process by either:  
• Clicking on the Download data from Instrument button on the Instrument 

Panel (Figure 33). 
• Clicking on the Download data from Instrument button on the Welcome to 

U2CI Window (Figure 1) or: 
• Selecting the "DISCONNECT" command from the INSTRUMENT menu.  

Figure 33 
As the instrument is downloading a progress bar will appear. 
When the download is complete, the U2CI application will open a new Data Window and display 
the data.  
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Download interruptions 
If the download process is interrupted after the data transfer has started, the application will 
display an error message (Figure 34). 

 
Figure 34 

To recover from this: 
1) Click the OK Button, 
2) Make sure that: 

• The instrument's is awake and that the PC mode is set to "ON" (see Section 6.2). 
• The instrument is paired to your computer and the connection is active (see Sections 6.3 and 6.4). 
• The correct COM port is selected in the U2CI Preference/Port drop down menu 

(see Section 7.2). 
3) Restart the download. 

7.4 APPENDING NEW DATA TO AN EXISTING DATA WINDOW / FILE 
You may append data from multiple instruments into an existing Data Window / file: 
1) If it is not already, open the data file to which you wish to add data (see Section 8.1). 
2) Launch the download process (see Section 7.3). 
3) U2CI will display a window asking if you wish to append the new data to the currently active 

Data Window (Figure 35).  It will include the following choices. 

• OPEN NEW WINDOW: Click this button to open a new Data Window and download the data there. 
• CANCEL: Click this button to halt the download process and leave any open Data Window 

unchanged. 
• OK: Click this button to download data into this Window / File. 

– The new data will appear at the bottom of the window. 

 

 
Figure 35 
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7.5 ASSIGNING A NAME TO AN INSTRUMENT 
You can assign a name to an instrument so that the instrument name is always associated with 
data downloaded from that instrument.    

• The name will appear in the NAME column of the Data Window. 
To assign a name to an instrument 
1) Make sure that: 

• The instrument is awake and that the PC mode is set to "ON" (see Section 6.2). 
• The instrument is paired to your computer and the connection is active (see Sections 6.3 and 6.4). 
• The correct COM port is selected in the U2CI Preference window(see Section 7.2). 

2) Open the Assign Name dialogue box by: 
• Clicking on the "ASSIGN NAME" button in the Instrument Tool Panel  

(Figure 36). 

Figure 36 
• Selecting the "ASSIGN NAME" under the Instrument menu (see Section 4.3). 

3) Type the desired name into the dialogue box that appears (Figure 37). 
• Maximum length is 8 characters. 

 
Figure 37 

4) Click the "OK" button to store the name in the instrument's memory. 
• This will overwrite any name already given the instrument.  
– To Undo this action you must rename the instrument using the old name.. 

• Click the "Cancel" button to abort the operation. 



U2CI Software Application – Operation Manual for MAC OS 

U2CIV3OM-MAC 23JL14 Page 23 of 43 

7.6 SETTING THE INSTRUMENTS DATE AND TIME 
You can update or change the date and time settings for your Myron L Company instrument via 
the U2CI application. 
To assign a set or reset the internal Date or Time of an instrument. 

1) Make sure that: 
• The instrument is awake and that the PC mode is set to "ON" (see Section 6.2). 
• The instrument is paired to your computer and the connection is active (see Sections 6.3 and 6.4). 
• The correct COM port is selected in the U2CI Preference/Port drop down menu 

(see Section 7.2). 
2) Open the Date / Time dialogue box by: 

• Clicking on the "SET DATE / TIME" button in the Instrument Panel (Figure 
38).  

• Selecting the "SET DATE / TIME" command under the Instrument menu (see 
Section 4.3).  

Figure 
38 

3) The following dialogue box will appear (Figure 39): 

 
Figure 39 

• The default settings should match your computers current date and time settings.   
• ALWAYS check to make sure that they do. 

4) Use the controls in this window to correct the date and time if the default settings are not 
correct. 
• Click the "OK" button to download the date and time settings shown in the dialogue box to the 

instrument.   
– This will overwrite the current date and time settings for the instrument. 
– if you have changed the date and time using the U2CI window controls, this WILL NOT reset your 

computer's date and time. 
• Click the "Cancel "button to abort the operation and leave the Date / Time of your instrument 

unchanged. 



U2CI Software Application – Operation Manual for MAC OS 

U2CIV3OM-MAC 23JL14 Page 24 of 43 

7.7 ERASING MEASUREMENT DATA FROM AN INSTRUMENT 

WARNING! 
 This action can not be undone. 

You may use the U2CI application to erase the recorded readings stored in your Myron L 
Company instrument.  

• This function erases all of the recorded readings stored in the instrument's memory. 
• It does not erase calibration constants, preference settings, date and time settings, etc. 

To erase the data records of an instrument 
1) Make sure that: 

• The instrument is awake and that the PC mode is set to "ON" (see Section 6.2). 
• The instrument is paired to your computer and the connection is active  

(see Sections 6.3 and 6.4). 
• The correct COM port is selected in the U2CI Preference window (see Section 7.2). 

2) Open the Erase Memory dialogue box by: 
• Clicking on the "ERASE MEMORY" button in the Instrument Panel (Figure 

40).  

• Selecting the Erase Memory command under the Instrument menu  (see 
Section 4.3).  

Figure 
40 

3) The following dialogue box will appear (Figure 41): 

 
Figure 41 

4) Click the "OK" button to proceed. 
• Click the "Cancel" button to abort the erase operation and leave the instrument's memory 

unchanged. 
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8. U2CI FEATURES 
8.1 LOADING A SAVED .mlc FILE 

Once a file has been saved as an encrypted .mlc formatted file it can be reloaded into the U2CI 
application. 
A) Load a previously saved .mlc data file use one of the following methods, either 

• Selecting the "LOAD" under the "FILE" menu or;  
– The standard MAC OS Browse window will appear. 
– Only .mlc formatted files may be selected. 

B) Select the "OPEN RECENT" command from the "FILE" menu (Figure 42). 
•  A drop down menu will appear that displays the most recently opened .mlc files. 

 
Figure 42 

 

C) Files can also be opened from the U2CI Welcome Window (Figure 43) by either:  
• Clicking on "Load existing Document" 
– A standard MAC OS Browse window will appear. 

• Clicking on one of the entries in the "Recent Cases" list: 

 
Figure 43 

NOTES:   
• Data exported using the Save As command in other formats (.xls, .xlsx, .csv and .pdf) can not be re-

loaded into the U2CI application. 
• If the file location has been changed or renamed from outside of the U2CI application the U2CI 

application will still be able to find and open the .mlc file. 
• Once a file is deleted, it will no longer appear in the  Open Recent list. 
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8.2 SAVING A DATA IN ENCRYPTED .MLC FORMAT 
The U2CI application is designed to keep your data secure and unadulterated. The Save 
command automatically exports the contents of the currently active Data Window to an encrypted 
.mlc file format that can not be read or edited by other types of software. 
.To save the data in a new or updated Data Window: 

• Click on the "SAVE" button in the Command Ribbon (Figure 44).   

 

Figure 44 

• Select the "SAVE" under the File menu. 
If the document has been changed but not previously saved, a standard MS Windows Save 
dialogue box will open that allows you to  (Figure 45).  

 
Figure 45 

NOTES: 
• The Save command automatically exports the data as an encrypted, .mlc-formatted file.  
• Only files saved in this manner can be re-opened by the U2CI application. 
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8.3 EXPORTING DATA IN AN OPEN FORMAT (SAVE AS) 
The U2CI application also allows you to export data so that it is useable by other programs by 
using the Save As command under the File menu. 
The following file formats are available when using the Save As command and create editable 
files: 

• MS Excel 97-2004 (.xls). 
• MS Excel 2007 and later (.xlsx). 
• Comma Separated Values format (.csv). 
• Portable Document Format (.pdf). 

 

To export data from an open U2CI Data Window; 

1) Open the Save as Dialogue Box by selecting the "SAVE AS" command under the File menu. 
2) A standard MAC OS Save As window will open. 
3) Choose a location on your computer to which the exported file will be saved. 
4) Choose the preferred format from the File Format drop down menu at the bottom of the MAC 

OS dialogue box. 
5) Give the file a title.  
6) Complete the process by either: 

• Clicking  "SAVE" to proceed with the export process or; 
• Click "CANCEL" to halt the operation. 

NOTES: 
• These formats are not encrypted and you will not be able to reopen the exported copies of the data 

using the U2CI program. 
• The .pdf format has the Optical Character Recognition option turned off and is not editable. 
• Unlike the other Save As operations in many other types of MAC OS software, this feature does not 

rename the open .mlc file or convert it to the chosen format. 
– Instead it creates a copy of the data, in the chosen format, at the location specified in the Save As 

Dialogue Box. 
– These copies will not appear in the Recent Files or Recent Cases menus. 

• Values of measurements will be exported in their original, non-truncated, non-rounded state so that 
data exported is at its full resolution.  
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8.4 PRINTING AND PAGE SETUP 
U2CI data can be printed using the Page Setup and Print commands.   These files can be printed 
in either Portrait or Landscape orientations. When printed: 
• The Data tab will print on first. 
• The contents of the Reference Info Field will appear at the bottom of the last page of the data 

printout. 
• Each graph will be printed on a separate page following the data printout. 

PAGE SETUP:  
1) Open the page setup dialogue box by: 

• Selecting the "PAGE SETUP" command under the File menu, or; 

2) A Page Setup dialogue box will appear. 
• The exact layout and content of this dialogue box will be dependent on the specific printer drivers 

installed on your system. 

 
PRINTING:  
1) Open the page setup dialogue box by either: 

 

 
• Clicking on the "Print" button in COMMAND Ribbon. (Figure 46). 

Figure 46 

• Selecting the "PRINT" command under the File men. 

2) A Print dialogue box will appear. 
• The exact layout and content of this dialogue box will be dependent on the specific printer drivers 

installed on your system. 
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8.5 ADDING REFERENCE INFORMATION 
Each Data window includes a Reference Info field that is an editable field that appears at the 
bottom of the Data Window where the user can add general notes or supplementary information 
about the data.  
You can Show or Hide this field by either: 
• Clicking the "REFERENCE INFO" icon on the Command Ribbon  

(Figure 47); 

Figure 47 

• Selecting the "REFERENCE INFO" command under the Edit menu. 
Place the cursor anywhere within the Reference Info Field at the bottom of data window and click. 
• A blinking text cursor (a vertical line) will appear.  You may now begin entering information. 
• Once you have completed entering or editing the reference information, Use the standard Save 

command to retain the information. 

NOTES:  
• Repeating any of the above actions will toggle Show/Hide the Reference Info field and any 

information entered there.. 
• The Reference Info field will accept all standard alpha numeric characters available in the Ariel font 

set for your MAC OS including manual line breaks (Return key). 
– MAC OS users may add various special characters by using the "SPECIAL CHARACTER" command 

under the Edit menu. 
• If the contents exceed the vertical size of the window a vertical scroll bar will appear. 
• You may change the vertical size of the Reference Menu field by:  
– Moving the cursor over the border line at the top of the Reference Info field. 
– Pressing and holding the primary mouse button. 
– Dragging the header border up or down until the  column is the desired height. 

• See Table 1 for a list of keyboard short cuts (Copy. Paste. Etc.) that can be used when editing the 
Reference Info Field. 
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8.6 SORTING DATA  
QUICK SORT:   
1) Click the Column heading of any column (except the "#" column) to sort the entire data file 

according its the contents .    
• The first time you click a column it will sort the file in ascending order according to that column. 
• Each time you click the same column the application will alternate between ascending and 

descending order. 

Table 2 – Data Field Sorting Styles 

Column  Data type Sorting method 
# N/A This column includes the line number within the data table and is not sortable. 

Record # Value Field Numeric Sorting 

Measurement Text Field Alphabetic Sorting – Not case sensitive 

Value Value Field Numeric Sorting 

Unit Text Field Alphabetic Sorting – Not case sensitive 

Solution Text Field Alphabetic Sorting – Not case sensitive 

Temp Value Field Numeric Sorting 

Date Date Field Date Sorting: Numeric sorting by Year 1st, Month 2nd; Day 3rd. 

Time Time Field Time Sorting: Numeric sorting by Hours 1st, Minutes 2nd, Seconds 3rd. 

FCe-ORP Value Field Numeric Sorting 

FCe-pH Value Field Numeric Sorting 

LSI-ALK Value Field Numeric Sorting 

LSI-HARD Value Field Numeric Sorting 

LSI-pH Value Field Numeric Sorting 

Instrument Text Field Alphabetic Sorting – Not case sensitive 

Location Text Field Alphabetic Sorting – Not case sensitive 

 
NOTES: 

• Numeric Sorting: Numeric fields are sorted as numbers. Ascending order would be:  
– 1, 2, 3, 4, 5, 6, 7, 8, 9, 10, 11 .... 20, 21, ... 30,31 ... 

• Alphabetic Sorting:  Text Fields are sorted alphabetically. Numbers are treated like words, NOT 
numbers,  with each numeral considered to be a separate letter) Ascending order would be: 
– 1, 10, 11, ... 2, 20, 21, ... 3, 30, 31 ....  (space) ! " # $ % & ( ) * , . / : ; ? @ [ \ ] ^ _ ` { | } ~ + < = > A B C D 

E F G H I J K L M N O P Q R S T U V W X Y Z. 
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MULTI-KEY SORTING 
Multi-key sort allows you to sort the contents of any open data window using, three, NESTED, sort 
keys.  To use this feature: 
1) Open the Sort dialogue box by: 

• Clicking on the "SORT" Button in the COMMAND Ribbon at the top of the Data 
Window (Figure 48).   

Figure 48 
• Selecting the "SORT" command under the Edit menu or;  

2) The following Window will appear (Figure 49): 

 
Figure 49 

3) For each of the nested sort keys,  
• Use the drop down menus from this window to select a data column for each of the three keys. 
– The default setting for each KEY is "NONE".  
– Choosing "NONE" deactivates that key. 

• Select whether to sort in ascending or descending order. 
4) Click the "OK" button to proceed. 

• Click the "Cancel" button to abort the operation. 

NOTE:  
• Setting all three keys to "NONE" will reset the contents of the data window to their original download 

order. 
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8.7  PREFERENCES  
The U2CI Preference Dialogue box allows the user to: 
• Select which COM port and therefore with which Instrument the U2CI application will be 

interacting. 
• See Section 7.2 above for instructions. 

• Change the manner in which the following data is displayed: 
• Temperatures 
• Dates 
• Times 

• These display format settings effect all tabs in the open Data Window, including Graph Tabs. 

To gain access to the  
1) Open the Preferences dialogue box by: 

• Select the "PREFERENCES" command from the U2CI menu, or:  

• Type   

2) The following dialogue box will appear (Figure 50). 

 
Figure 50 

3) Select preference choices using the drop down menus.   
• Temp Scale:  This drop down menu allows you to choose between displaying temperature 

data in either °C (Celsius) or °F (Fahrenheit). 
• Time Format: This drop down menu allows you to choose between displaying times as either 

AM / PM values or in a 24-hour Clock format (e.g. 4:00PM = 16:00) 
• Date Format: This drop down menu allows you to choose between displaying dates in either: 

• Day First Format (DD-MM-YYYY).   
• Month First format. 
• Year First Format (YYYY-MM-DD).  
• Format choice does not effect the sort order for dates. 

4) Once you have made your selections   
• Click "RESTORE DEFAULTS"  to reset all of the preference settings to their default selections. After 

resetting the preferences: 
• Click "OK" to save the chosen preference settings and close the dialogue box. 
• Click "CANCEL" to close the dialogue box without saving the preference settings. 
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9. SIMPLE GRAPHS 
9.1 GENERAL GRAPH INFORMATION 

The U2CI application can be used to produce simple graphs of the data in a single window.   
• Currently the graph feature can only create graphs based on measurement type, such as: 

• All pH values,   
• All COND values,  
• All ORP values, etc. 

• You CAN NOT limit the graph range to only include only some of the values of a type. 
Example: pH values between May 1st and May 10th". 

• These graphs can be one of two types: 
• A line graph of one type of measurement. 
• Histogram of one type of measurement. 

• Once a graph is created a separate tab will appear in the data window in which the graph is 
displayed (Figure 51). 

 
Figure 51  

 
NOTE: If a more complex type of graph is desired, export the data .xls or .xlsx file and import it 
into MS Excel. 



U2CI Software Application – Operation Manual for MAC OS 

U2CIV3OM-MAC 23JL14 Page 34 of 43 

9.2 CREATING SIMPLE LINE GRAPHS 
To create a Line Graph:  
1) Select the Data Tab of an open U2CI Data Window. 
2) Open the New Graph dialogue box by select the "NEW GRAPH" button in the Command 

Ribbon (Figure 52). 

 
Figure 52  

3) Open the New Line Graph dialogue box by clicking  the "LINE GRAPH" button at the top of the 
New Graph dialogue box (Figure 53). 

 
Figure 53  

• NOTE: You can also open the New Line Graph dialogue box directly by: 

• Typing  

• Selecting "NEW LINE GRAPH" from the "GRAPH" menu (Figure 54). 

 
Figure 54  

 
4) The following dialogue box will open (Figure 55). 
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Figure 55  

5) Use the following fields, menus and buttons to define the parameters for your graph. 
• Graph Name: Type the name you wish to appear in the Data Window's Graph Tab. 
• Graph Title:  Type the title that is to appear ON the graph. 
• Measurement Type: Use this drop down menu to select which type of value will be used in the 

graph. 
• Vertical Axis Label: Type the label to appear next to the graph's vertical axis. 
• Horizontal Axis Label: Type the label to appear next to the graph's Horizontal axis. 
• Horizontal Data: Use this drop down menu to chose how the data labels for the Horizontal axis are to 

be created.  The choices are: 
– Record # Field:  
– Date Field:  
– Date and Time Field: 

• Include Date and Time:  Checking this box will cause the date and time the graph was created to be 
displayed on the graph. 

6) Click the "OK" button to build the graph. 
• A new Graph Tab will appear in the Data Window (Figure 56). 
• Click the "Cancel" button to abort the graph creation process. 
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To view the graph, click on the newly created Graph Tab. 
 

 
Figure 56  
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9.3 CREATING SIMPLE HISTOGRAM 
To create a Histogram:  
1) Select the Data Tab of an open U2CI Data Window. 
2) Open the New Graph dialogue box by select the "NEW GRAPH" button in the COMMAND 

Ribbon (Figure 57). 

 
Figure 57  

3) Open the "HISTOGRAM" dialogue box by clicking  the "HISTOGRAM GRAPH" button at the 
top of the New Graph dialogue box (Figure 58). 

 
Figure 58  

• NOTE: You can also open the "Histogram" dialogue box directly by: 

• Typing  

• Selecting "NEW HISTOGRAM" from the Graph menu (Figure 59) . 

 
Figure 59 

4) The following dialogue box will open (Figure 60). 
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Figure 60  

5) Use the following fields, menus and buttons to define the parameters for your graph. 
• Graph Name: Type the name you wish to appear in the Data Window's Graph Tab. 
• Graph Title:  Type the title that is to appear ON the graph. 
• Measurement Type: Use this drop down menu to select which type of value will be used. 
• Vertical Axis Label: Type the label to appear next to the graph's vertical axis. 
• Horizontal Axis Label: Type the label to appear next to the graph's Horizontal axis. 

• No. of Bins: This field controls the number of "Bins", or vertical bars, into which the values will 
be divided on the Histogram.  To estimate the number of bins use the square root of the 
number of values (round down). 
– EXAMPLE: if there are  26 pH measurements the estimated number of bins would be: 

  

€ 

26 = 5.099 or 5 

• Include Date and Time:  Checking this box will cause the date and time the graph was created to be 
displayed on the graph. 

6) Click the OK button to build the graph. 
• A new Graph Tab will appear in the Data Window. 
• Click the "Cancel" button to abort the graph creation process. 
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Figure 61  
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9.4 EDITING AND CHANGING GRAPHS 
Once created, graphs can be edited and updated. 
Appended Data:   
If new data appended to an exiting data file of a measurement type included in an existing Graph 
Tab, the graph will automatically update to include the new data. 
• Example: If additional pH data is added to a data file that includes a graph of pH values, the 

graph will automatically update to include the new pH data. 
NOTE:  Because it is not possible to limit the range of the graphs by more than the measurement 
type, if a separate graph is desired for the new data, it must be downloaded into a separate, new 
Data Window and not appended to a previous data file. 
• Example: To have separate graphs for pH data from February of 2013 and March of 2013, the 

February measurements must be downloaded into s separate data file from the March 
measurements. 

Manually Editing a Graph:   
To manually edit an existing Graph: 
1) Select the Tab to be edited. 
2) Select either: 

• The "EDIT GRAPH" button in the Command Ribbon (Figure 61): 

 
Figure 62  

• The "Edit Graph" command from the Graph menu (Figure 63).  

 
Figure 63  

• Or type  

3) A Create Graph window will open for the appropriate type of graph (Line or Histogram). 
• The various fields will auto fill with the current graphs information. 

4) Make the desired changes. 
5) Click on the "OK" button to redraw the graph with the changed settings. 

• Click the "Cancel" button to abort the process. 



U2CI Software Application – Operation Manual for MAC OS 

U2CIV3OM-MAC 23JL14 Page 41 of 43 

9.5 DELETING A GRAPH FROM A DATA WINDOW 

NOTE:  
This can not be undone. 

To delete a graph from a Data Window: 

6) Click the "X" at the left of the Graph Tab to delete the graph (Figure 64). 

 
Figure 64  

 
7) A confirmation dialogue box  will appear (Figure 65).    

 
Figure 65  

8) Click "OK" to permanently delete the Graph Tab from the Data Window / File. 
• Click " Cancel" to keep the Graph Tab in the Data Window / File. 
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10. TROUBLESHOOTING 
10.1 ERROR MESSAGES 

At various times during its operation the U2CI application may issue an error message. The most 
common place this can occur is if the user attempts to perform any action that requires the U2CI 
application to communicate with a Myron L Company Instrument, but: 

• The instrument is asleep. 
• The instrument is awake but the PC mode is still set to "OFF" 
• The wrong COM port is selected in the Preferences/Port drop down menu. 
• The MAC OS Bluetooth preference window  indicates that the device connection is closed. 

If this is the case the U2CI application will display an error message. 
 
EXAMPLE: The user clicks the Assign Name button in the Tool Bar while the currently paired and 

connected Ultrameter is asleep. The following message will appear (Figure 66): 

 
Figure 66  

• Click the "CANCEL" Button to stop the process, or;  
• Correct the underlying connection issue by follow the instructions of Pairing and Connecting to an 

Instrument (Section 6 above), then Click the "OK" button to continue. 

The functions for which this type of Error message can appear are: 
• Downloading from Instrument 
• Assigning a Name 
• Setting the  Date and Time 
• Erasing Memory 
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10.2 OTHER TROUBLESHOOTING TIPS 
SYMPTOM: The REFERENCE INFO Window is missing from the bottom of the Data Window 
• CAUSE: The REFERENCE INFO Window is hidden.   
• SOLUTION: Unhide it by: 

• Clicking the Reference Info icon on the Command Ribbon (Figure 67); 

Figure 67 

• Selecting the "REFERENCE INFO" command under the Edit menu. 
• Placing the cursor anywhere within the Reference Info Field at the bottom of data window and 

clicking. 

 
SYMPTOM: "Cannot Connect" error message appears repeatedly during one of the following 
operation: 

• Downloading from Instrument 
• Assigning a Name 
• Setting the  Date and Time 
• Erasing Memory 

• CAUSE: The instrument and the U2CI application are having trouble communicating. 
• SOLUTION:  

• Check the following and correct it so: 
– The correct COM port is selected in the U2CI Preference window(see Section 7.2). 
– The instrument's is awake and that the PC mode is set to "ON" (see Section 6.2). 
– The instrument is paired to your computer and the connection is active (see Sections 6.3 and 6.4). 

• The Instrument's Bluetooth signal is too weak. 
– Try moving the Instrument closer to the host computer. 
Replace the battery (Even if the Lo Batt indicator is not lit on the Instrument display, the battery may be too 

weak to broadcast a strong signal). 
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